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Quick start 
Visual imaging (VIS)  
Light Source: Fillex lamps  
Filter: XNite CC1   
  
UV Luminescent Imaging (UVL)  
Light source: Triple Bright 3s  
Filter: CC1 on camera AND  
           Kodak 2E with adaptor  
  
UV Reflected Imaging (UVR)  
Light source: Triple Bright 3s  
Filter: XNite 330 AND XNite BP1   
  
IR Reflected Imaging (IRR)  
Light source: Surveillance panels  
Filter: XNite 830  
  
Visible Induced Luminescence (VIL)  
Light source: Disco lamps on red  
Filter: XNite 830  
  
Image Subtraction 660/735 bandpass (IS)  
Light source: Fillex lamps on 3200K  
Filter, first image: Midopt BP660   
  
Filter, second image: Midopt BP735  
  
 NOTE: All filter cases should be labeled with their respective techniques! 
 

RGB Channel movement 

UVRFC: VIS Green -> Red 

   VIS Blue -> Green 

    UVR-> Blue 

IRRFC: VIS Green-> Blue 

VIS Red -> Green 

IRR -> Red 



Background 
 

Multiband terminology & concepts 
Band-pass—a filter that only lets through light in a certain “band” of wavelengths, lit. “band of passing through.”  
Used for image subtraction (MidOpt BP660 and 735) for identifying indigo. 

 

False-color imaging—A technique where RGB color channels from visual imaging are recombined with UVR or IRR 
imaging to gain more information about the materials.   

For UVRFC: VIS green channel --> red channel 

VIS blue channel --> green channel 

UVR image (B&W) --> blue channel 

For IRRFC: VIS red channel --> green channel 

VIS green channel --> blue channel 

IRR image (B&W) --> red channel  

For these techniques to be successful all images must be correctly calibrated for exposure based on the 
Spectralonâ standards. 

 

NOTE:  Terminology is not standardized, the AIC photo guide uses FCIR and FCUV instead of IRRFC and 
UVRFC respectively.  UVL is also occasionally called UVF (Ultra Violet Fluorescence) 

 

Flat-fielding—the process by which you compensate for inconsistent lighting.  With good lighting and the quartz 
Janoptik lens this may not be necessary.  A picture is taken of a piece of blue board (or other uniform reflector) 
under the lighting to be used and set as a LCC profile in Capture One.  When applied to an image this will cancel 
out uneven lighting. 

 

Gamma function/profile-- an adjustment applied by the camera to make images look more natural to our eyes, 
which do not perceive all wavelengths evenly.  Can be removed and replaced with a linear response in Capture 
One if images are shot as RAW files. 

 

Image subtraction—any technique that subtracts one image from another to visualize the difference between 
them.  The IS 660/735 technique used in this imaging suite is used to detect indigo and other blue/black dyes, by 
visualizing the difference between the reflectance of the object at light of 660 nm and 735 nm in wavelength.  For 
more details see Webb, 2014. 

 



Luminescence/fluorescence imaging—these two are used interchangeably in the literature, there seems to be 
some regional variation.  Light shining on a substance causes it to give off different light.  Because of the law of 
conservation of energy, the light output must be lower energy (longer wavelength) than the input light. 

UV illumination causes luminescence/fluorescence in the visual 

Blue light in the visual can create red luminescence (See Dyer 2017) 

Red light in the visual causes IR luminescence/fluorescence 

 

Reflectance imaging—the light that is reflected off the object is collected by the camera and makes the picture.  
“Normal” photography is visible reflected imaging 

  



Important tools in Capture 1 
 

Workspace 

 

The Capture 1 workspace is divided into three major sections.  On the left hand side are several tabs that 
correspond to different tasks—“Tether” for shooting with a tethered camera, “Library” for looking at file 
organization, and “Adjust” for adjusting Levels, Curve, Exposure, Saturation, etc.  The “Shape” “Style” and 
“Refine” tabs will not be used in this workflow.  This area is highlighted in green. 

 

On the right side are thumbnails of the images that have been taken so far.  These can be color-coded, rated, and 
deleted.  Right-clicking on an image brings up a large menu of options.  This section is highlighted in red 

 

The central plane shows the image (or images) currently being viewed or edited. 

At the center top are cursor tools, many of which have drop-down menus that may be useful.  The White Balance, 
Normalize, Add Color Readout, Delete Color Readout, and Hand tools can be found here.  This is highlighted in 
yellow. 

 

Camera 
When a camera is plugged in and turned on for capturing tethered images, information about the camera settings 
will be shown here.  Shutter speed, aperture, and ISO can all be adjusted using this tool. 



 

It is recommended to shoot at ISO 100 and f8, with the shutter speed adjusted as necessary to achieve an 
appropriate exposure.  The following are good starting places for the various techniques: 

 

VIS—1/1.3 

IS 660—3s 

IS 735—6s 

UVL—30s 

UVR—5s 

IRR—1/1.3 

VIL—4-12 minutes using the bulb setting, remote release cord, and f4 (6 minutes is a good starting point, 
although keep in mind that some synthetics fluoresce very strongly in the IR and may require a shorter exposure) 

 

 

Because the quartz Janoptik lens used for this system is manual focus only, the focus must be physically modified 
on the lens and cannot be changed in Capture 1. 

 

File naming protocols 
The standard file name for multiband images is as follows: 

ACCESSION_NUM_MB_TECHNIQUE_YEARMONDAY 

For example, if 1950.1.2 was shot on January 1, 2021, the images would be labeled: 



1950_1_2_MB_XYZ_202111 

where XYZ is the applicable imaging technique. 

When opening a Capture One session, the session is named ACCESSION_NUM_MB, and the rest of the file name 
format is saved in Capture One as <TM standard>.  The technique portion of the name must be modified manually 
as the session progresses. 

 

 



Normalize 

 

The normalize tool is used in VIS imaging to simultaneously adjust white balance and exposure.  The lightest grey 
square on the Color checker mini is adjusted to RGB (200, 200, 200) 

Base characteristics 

 

All images must have their Curve set to Linear Response to account for the camera’s gamma function and provide 
accurate images.   

 

White Balance 

 



The white balance tool is similar to the normalize tool but adjusts white balance only.  Clicking on a known neutral 
grey value with white balance engaged will correct the entire image.  This tool is used in UVL to white balance to 
the UV reference greyscale. 

 

Color readout tool 
The color readout tool can be accessed from the cursor tools bar (yellow in the Capture 1 workspace image) in a 
drop-down menu that also includes Normalize and White Balance. 

 

For the tool to work properly, Lab readout must be turned on (under View-> Lab readout-> generic) 

Clicking on a location in the image shows a readout of the L*a*b* measurements for that spot. 

 

Because the Spectralonâ reflectance samples have known reflection percentages of 2% and 98% across all 
wavelengths of light, the L values should be 2 and 98.  Images that are close can be adjusted using the levels tool. 

Color readouts can be deleted by clicking on them while the Delete Color Readout tool is active. 



Levels  

 

To adjust the L values of the white and black Spectralonâ samples, the white and black points on the levels tool 
are adjusted by grabbing and sliding.  Generally, both the white and black points will need to be moved in to 
achieve appropriate L values.  Adjusting one modifies the other, so some back and forth will be necessary. 

Exposure and saturation 

 

The Exposure tool contains four sliders, only two of which are utilized in this imaging protocol.  Exposure is used 
to adjust the color readout in UVL to an L value of ~50, while saturation is used to change single-channel images 
(UVR, IRR, IS 660, IS 735, and VIL) to greyscale.  This is preferred to using the Black and White tool in Capture 1, 
which is designed to modify artistic B&W images. 

 

Export 

 

Right-clicking on an image thumbnail will bring up a long list of options, including Export.  Images should be 
exported to the default folder (session output) and saved as 16-bit .tif files.   

 



Materials used 
The Multi Bond Car(t) should contain the following: 

• 1 Nikon 610 modified for MBI 
o This should be equipped with a quartz Janoptik UV-VIS-IR 60 mm 1:4 APO Macro lens and quick-

release plate for the Manfrotto tripod head 
o The camera bag should also contain a spare battery, battery charger, hotshoe level, and a remote 

release cord for long exposures 
• 1 Desktop computer equipped with Capture One and Adobe Photoshop 
• 2 folding lamp stands 
• 1 lamp stand weight 
• 2 Fiilex P360S Portable LED Light (2800-6500K) lamps for VIS and IS 660/735, associated cables, and 

diffusers 
• 2 Triplebright UV sources for UVL and UVR, mounted to Kupo superknuckles for attachment to a lamp 

stand 
• 2 IR surveillance panels for IRR, mounted to Kupo superknuckles, and assorted cables 
• 2 American DJ 64B LED color lamps for VIL 
• 4 Manfrotto magic arms (use optional) 
• 2 Multi-outlet extension cords 
• Nikon tethering cable 
• Color standards including 

o Xrite calibrite classic mini 
o ISA UV target (luminescence standard) 
o Spectralonâ reflectance standards at 98% and 2% reflectance 

• Filters (see quick-start guide) 
• Black lab coats 
• Safety glasses 
• Multiband back-up drive 
• All documentation for light sources, filters, etc. (with color standards) 

 

Image capture 
Imaging space 
The goal of the imaging set-up is to evenly illuminate the object, as well as have it consistently in-focus.  With the 
flexible material in The Textile Museum collection, this is most easily achieved with the camera pointed 
downwards and the object flat on a table.  Because the Janoptik lens has a narrow field of view, it is best to lower 
the tables to have as much of the object in the frame as possible.   

Object set-up 
Ensure the object is as flat as possible, as wrinkles and creases will cause shadows in the final images that make 
interpretation difficult.  The Colorchecker Mini, UV Luminescence standard, and Spectralonâ reflectance 
standards must also be in the frame, ideally in the same plane as the object.  Due to the common nature of 
pesticide contamination in the TM collection, place a barrier between the object and the standards.  This can be 
any material that does not fluoresce under UV—blue board works well, muslin is an option (although not ideal) 
and archival Mylarâ is yet to be tested. 



Stand set-up 
It is critical to use an extremely steady camera support for multiband imaging, as some exposures are very long.  It 
is also essential to ensure that the VIS, IRR, and UVR images align properly to generate false-color images 

 

As of 2023, The Textile Museum uses a CAMBO stand with counterweighted cross-arm.  The arm controls are 
shown above. 

 

The modified Nikon 610 is mounted to a quick-release plate that is attached to a Manfrotto tripod head with 
three-axis rotation. The camera is attached to the tripod head by pressing the lever all the way across and slotting 
the quick release plate into the adaptor notch.  The lever will click and swing back when the plate is in place.  
Release the camera by doing the reverse. 

 

 The hotshoe level can be used to check that the camera body is flat—often the 90° marker on the tripod head is 
not exactly flat.  A larger level can also be used to check that the bottom of the lens is horizontal.  Be sure to check 
this every time, even if the head has not been adjusted—often there is a small amount of drift. 



 

Tether the camera to the computer and turn it on.  Open Capture 1, begin a new session, and use live view to 
adjust the stand and crossarm so that the appropriate field of view is seen and focus the camera.  Once the 
camera is in place, lock the arm and raise the casters until the stand touches the floor.  Double-check that this has 
not influenced the image focus.   

 

Image capturing 
Each object should have its own Capture 1 session.  Start by opening Capture 1 and selecting File -> New Session, 
and name the session ACCESSION_NUM_MB. 

Set the Base Characteristics curve to Linear 

Under Next Capturing Naming click the three dots to bring up Naming Format and select <TM standard> 

Use live view to check the image focus, double clicking with the hand tool to zoom in on particular areas. 

In general, the image capturing process proceeds as follows: 



1. Place the appropriate light sources on both stands and place them on opposite sides of the object.  The 
light sources should be angled down at ~45º 

a. For the UV sources, plug in the YELLOW cord at least 20 seconds before plugging on the plain one 
2. Attach the appropriate filters to the lens 
3. Double-check that Base Characteristics is set to Linear Response 
4. Change the capture name in Capture 1 to the next technique and restart the capture counter 

5. Turn off the overhead lights! 
6. Take several images, adjusting the shutter speed until an appropriate exposure is reached.  Generally a 

color readout of the Spectralonâ reference standards of ~70 for the 98% and ~15% for the 2% are 
sufficient 

 

Notes 
• Protective eyewear is required when UV lights are on!  If you wear glasses, this is sufficient, but the Multi 

Bond Car(t) also has safety glasses.  Put a sign up on the door to warn others to knock before entering 
when using UV/IR sources.   

• While eyewear is not necessary for working with IR, it is still not a good idea to look directly at the panels 
• There are different ways of marking selected images.  All the others can be deleted by selecting their 

thumbnails and hitting the “Delete” key on your keyboard.  This does not delete them permanently it 
instead moves them to the session trash.  There are also rating systems built into the thumbnail panel of 
Capture 1 that can be utilized. 

• Remember to turn the camera off when image capture is done to save battery 

 

Adjustments and processing in Capture 1 
 

Visible Reflected Imaging (VIS) 
1. Normalize the light grey square of the color checker to RGB (200, 200, 200) 
2. Place a Color Readout reference on both the white and black Spectralonâ references 
3. Adjust the white and black points in the Levels tool until the L values are 98 and 2 respectively for the 98% 

and 2% Spectralonâ references 

 

660/735 bandpass subtraction (IS) 
1. Convert image to greyscale by adjusting saturation to -100 
2. Adjust the white and black points in the Levels tool until the L values are 98 and 2 respectively for the 

white and black references 

 

Ultra-violet Luminescent Imaging (UVL) 
1. White balance the selected image using any of the greyscale squares on the UV reference 
2. Turn on Lab readouts under View-> Lab readout-> Generic 
3. Select the reference square with a similar value to any fluorescence of the object and place a Color 

Readout reference on that square 
4. Adjust the exposure until the L value of the color readout is ~50 



 

Ultra-violet Reflectance Imaging (UVR) 
1. Convert image to greyscale by adjusting saturation to -100 
2. Place a Color Readout reference on both the white and black Spectralonâ references 
3. Adjust the white and black points in the Levels tool until the L values are 98 and 2 respectively for the 

white and black references 

 

Infra-red Reflectance Imaging (IRR) 
1. Convert image to greyscale by adjusting saturation to -100 
2. Place a Color Readout reference on both the white and black Spectralonâ references 
3. Adjust the white and black points in the Levels tool until the L values are 98 and 2 respectively for the 

white and black references 

 

Visible-induced IR Luminescence Imaging (VIL) 
1. Convert image to greyscale by adjusting saturation to -100 
1. Place a Color Readout reference on both the white and black Spectralonâ references 
2. Adjust the white and black points in the Levels tool until the L values are 98 and 2 respectively for the 

white and black references 

 

Export all processed and selected images to the output folder! 

 

False-color and image subtraction in Photoshop 
Some post-processing needs to be done in Photoshop instead of Capture One.  This is also a good time to convert 
the images to .jpg format to upload to Museum Plus. 

Start by opening all session images in Photoshop.  UVL and VIL images are not needed for post-processing, so they 
can be exported as .jpgs (File-> Export-> Export As) and closed.   

Image subtraction 
1. Select the entirety of IS 660 by using CNTL+A and copy with CNTL+C 
2. Switch to the IS 735 window and paste (CNTL+V) 



3. IS 660 should now be a second layer in IS 735.  Select it, and change the layer interaction to Subtract 

 
4. The resulting image should be dark overall, with some lighter areas usually corresponding to blue, green, 

purple, or black portions of the textile.   
5. Flatten the image and save it as ACCESSION_NUM_MB_IS_DATE.tif, and export it as a .jpg. 

 

Generating false-color images 
Color images taken in RGB mode are made of three channels, each corresponding to a color.  False-color imaging 
takes single-channel (greyscale) images taken in IR reflectance and UV reflectance and integrates them into the 
color channels of a visible image to simultaneously provide information about the visible color of a region and its 
UV or IR behavior.   

To understand how these images are generated, it is important to understand how layer and channel selection 
works in Photoshop.  The select all (CNTL+A) tool will be used frequently, but this tool does not necessarily select 
everything present in an image. 

 



For example, in the screenshot above the Background layer is both visible (eye symbol) and selected (highlighted 
compared to other layers).  Using CNTL+A in this context will select all of Background, but none of Layer 1. 

This can be utilized to help generate false-color images. 

1. Copy the UVR image and paste into VIS (CNTL+A , CNTL+C in the UVL window, CNTL+V in the VIS window) 
2. Ensure that the VIS image (now Background) is visible and selected, while UVR (now Layer 1) is not 

selected and invisible. 
3. Click on the Channels tab next to Layers 

 
4. Once again, it is going to be important to ensure that only one of the color channels is selected and visible 

at once!  For UVR, select the Green channel (as shown above) and use CNTL+A, CNTL+C to copy it.  Click 
on the Red channel (which should now be selected) and using CNTL+V to paste. 

5. Repeat to move the Blue channel to Green. 
6. Return to Layers and deselect and hide Background.  Ensure Layer 1 (the UVL image) is selected and 

visible.  CNTL+A, CNTL+C to select the UVR image and copy it. 
7. Deselect and hide Layer 1.  Ensure Background is visible and selected.  Navigate back to Channels, click on 

Blue, and use CNTL+V to paste the UVR image into the blue channel.  Because UVR is a greyscale image, it 
is equivalent to the single-channel of a RGB image. 

8. Flatten image, save as ACCESSION_NUM_MB_UVRFC_DATE.tif and export as a .jpg 

A completed UVRFC image is shown below. 

 



This is repeated with IRR, only in this case Background’s Green is moved to Blue, Red is moved to Green, and the 
IRR image is inserted as the Red channel.   

 

Remember to flatten the image, rename it, and export as a jpg! 

 

  



Options for Analysis 
Once multiband images have been gathered, the results can be compared against standards with known dyestuffs 
to draw conclusions about which dyes have been used.  There are different ways of doing this, including flow 
charts (such as the following from Dyer et al, 2018).   

 

Note—Dyer et al refer to the 660/735 bandpass subtraction technique as MBR, not IS. 

However, it can be difficult to accurately compare colors to written descriptions.  Although this chart makes sense 
for publication, where figures that are legible when printed in greyscale are ideal, we are prototyping a different 
method. 



 

This chart contains all reference dyes known to be found in Central Asian Ikats (see Tamburini 2020).  All have 
been imaged using this multiband system, and representative color blocks generated using the eyedropper tool in 
Photoshop. 

Objects can then be compared to this chart, for ex: 



 

This ikat contains three colors—undyed silk, yellow, and blue.  The yellow regions are compared to flavonoid dyes, 
while the blue is compared to Indigo, Diamond Green (CI #42000), and Patent Blue 5 (CI #42051).  The IRRFC and 
UVRFC responses of the yellow dye do not match the flavonoid dye used in Central Asian Ikats, so the yellow 
cannot be identified.  The blue also does not match with the response expected for indigo, so it appears that the 
dye used is a synthetic, possibly Patent Blue 5. 

Image archiving 
Capture One sessions should be backed up on the Multiband Back-Up external drive.  

All output images (.tif and .jpg) are uploaded to Box in (Group) GWM-TM-Conservation-> IMAGES-> Analytical 
Imaging->Multiband in a folder labeled with the object accession number. 

.jpg files are added to an Analysis Report in Museum Plus under the Conservation module.  Use the following 
details for the report: 

Analysis type—Multiband Imaging 

Type details-- Visible, UV luminescent, UV reflected (false-color), IR reflected (false-color), visible-induced IR 
luminescence and 660/735 bandpass subtraction 

Method-- For details, see Multiband guide 2023 



Results/conclusions—any conclusions that you drew from the images. 


